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ABSTACT 

 
 
Our country with large number of disabilities, according to recent survey nearly 85 lakhs of people are 
affected by the disability in movements in which nearly 70% of people belongs to rural area and other 30% 
belongs to urban , People in rural are mostly illiterate and cannot afford for a caretaker. In such cases feeding 
the people with disability in movement of hand is a great challenge. The proposed methodology focuses on 
feeding of meals to the person with disability using a robotic arm. The proposed work mainly focuses on 
feeding meals to the person with disability without the help of caretakers and at affordable price. Existing 
techniques are quite costly which cannot be afford by the rural people of India and other few existing methods 
are quite based on technologies which cannot be understand by the people of rural India. Technologies that are 
used in this method are quite easy and understandable and cost is quite low compared to other devices 
available in the market.  
The proposed methodology comprises of four servo motors, one arduino controller and one power supply. 
switch is provided for the user to on anf off the feeding robot whenever its required,the robot feeds the 
disables on portion between the person and robot as to be adjusted before food feeding is to be stared. Arduino  
is programmed in such a way to co-ordinate the required movements of the arm. The desirable robotic arm 
position is accomplished by the rotation of servo motors. The assistive feeding device has 6 degree of 
freedom,1 servo motor rotated clock and anti clock,2 servo motor for height adjustments up and down 
movement and 1 motor as spoon to feed too and fro motion. 
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CHAPTER- 
INTRODUCTION 

------------------------------------------------------------------------------------  

 
 
 
INTRODUCTION 
 
 
Robots are playing a very important role in our day to day life. The main idea behind making any robot is to 
reduce human effort for feeding disable persons. Depending upon the requirements, different types of 
automated and self-controlled robots are being implemented. 
The growing number of elderly in institutional living increases the necessity of designing new assistive 
devices for elderly in residences. The desire to feed elderly and those with upper limb disabilities has captured 
the minds of many researchers and designers for decades. The desire to provide a neater, safer and more 
comfortable eating environment with the least dependence on nurses, caregivers and family members has been 
the major motivation of research in feeding devices, Simple electromechanical or mechanical machines  to 
complicated intelligent systems , have been designed toward providing user independence in Activities of 
Daily Living (ADL). simple assistive feeding devices all take advantage of electro-mechanical systems. The 
limited control of the users of elector mechanical feeders and recent advances in robotic related technology 
has led designers to apply more intelligence in assistive feeding systems. However, to date almost all of the 
proposed feeding systems have been single-user devices. the main components used in this robots are servo 
motors, arduino controller, ac adaptor,connecting wires and frame work using ply wood to reduce weight of 
the system. 
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CHAPTER- 
LITERATURE 

------------------------------------------------------------------------------------  

 
 
 
LITERATURE  
 
The Winsford feeder (Sammons Preston; Hermann et al., 1999) is a mechanical self-feeding  
system. It uses a mechanical pusher to fill a spoon and a pivoting arm to raise the spoon to  
the user’s mouth that is at a preset position. The plate is rotated to place more food in front of  
the pusher. The user can choose from two input devices: a chin switch and a rocker switch.  
Neater Eater (Neater Solutions) has two versions: a manual–operation-type and an  
automatic-operation-type system. Neater Eater consists of a two-DOF arm and one dish.  
Two types of food can be present on the one dish. The manual type can be used to suppress  
the tremors of a user’s upper limbs while he or she eats 
My Spoon (Soyama et al., 2003) is suitable in the case of Japanese food. It consists of a five- 
DOF manipulator, a gripper, and a meal tray. The meal tray has four rectangular cells. My  
Spoon combines several pre-programmed motions: automatic operation, semiautomatic  
operation, and manual operation. The semiautomatic operation allows a user to select food.  
The manual operation can change the position in which the food is held. The input device  
can be selected from among the following: the chin joystick, reinforcement joystick, and  
switch. The end-effector of the robotic arm has one spoon and one fork, which move  
together to realize the grasping motion. During the grasping process, the gap between the  
spoon and the fork changes and thus the end-effector grasps the food. Then the robot moves  
to a predefined position in front of the user’s mouth, and the fork moves backward to enable  
the user to eat the food off the spoon.  
Meal Buddy (Sammons Preston) has a three-DOF robotic arm and three bowls that can be  
mounted on a board using magnets. After the system scoops the food, the robotic arm  
scrapes the surplus food off the spoon with the rod on the bowls. 
The Mealtime Partner Dining System (Mealtime Partners) is positioned in front of a user’s  
mouth. Three bowls can rotate in front of the mouth. The spoon picks up the food and then  
moves a short distance toward the preset location of the mouth. This system reduces the  
chances of the spoon slipping on wet food because the underside of the spoon is wiped off  
after scooping. Because of the way the system is positioned, the user does not need to lean  
toward the feeder. In some systems, a beverage straw is located beside the spoon  
(Pourmohammadali, 2007). Other systems are designed for multiple users (Guglielmelli,  
2009). 
Most feeding systems scoop the food with a spoon. Those systems are not suitable for use in  
the case of boiled rice, which is a staple food in Korea. In addition, some systems have a  
single dish, and thus different types of food might be mixed during scooping. My Spoon  
uses the grasping function to pick up food, but this system has difficulty serving Korean rice  
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due to its fixed grasping strength and the grasping openness of the gripper. As a result, My  
Spoon’s gripper sometimes gets a lot of rice attached to its surface. The previously  
mentioned self-feeding robotic systems also have difficulty scooping this staple Korean  
food. 
Feeding robots enable users to enjoy food independently during mealtimes. After preparing  
food, users can choose when they want to eat the desired food. We developed an assistive  
robot for self-feeding by taking into consideration the feedback of user candidates and  
clinical experts. We evaluated the self-feeding robot by performing a series of user tests. The  
overall process, i.e., formulating a concept, design, and evaluation involves feedback from  
users and clinical experts. The development process is performed on the basis of the  
philosophy of participatory action design (Ding et al., 2007).  
 
USER 
 
The primary users of self-feeding robots are people with physical disabilities who have  
difficulty moving their upper limbs. Such people include those suffering from high-level  
spinal cord injuries, cerebral palsy, and muscular diseases. For example, people with  
cervical level-4 spinal cord injuries have difficulty moving their upper limbs and retain full  
movement only above their necks. Some people afflicted with cerebral palsy cannot move  
their arms and hands, and they often have difficulty moving their necks. When the spoon of  
a self-feeding robot approaches such a user’s mouth, that person has a hard time putting the  
food in his or her mouth. People with muscular diseases have weak muscle movements.  
Even though they can move their hands, they have limited motor functions in their elbows  
and shoulder joints. We can also include senior citizens who have difficulties with the motor  
functions of their upper limbs, e.g., the fragile elderly, among the abovementioned disabled  
people. It is clear that the number of overall target users of self-feeding robots will be  
growing in the near future.  
 
 

Aging Population and Escalation of Required Services 
Older adults are the fastest growing group in North America, Europe, and Asia . As demonstrated in Table 2-1 
, which shows the number of Canadians over age 65 as a percentage of the total population, by 2016, almost 
16% of all Canadians will be aged 65 and over. In addition, Figure 2-1 demonstrates the increasingly fast rate 
of growth expected of the Canadian elderly population in the future compared to just a few years ago. The 
United States also expects a dramatic increase both in number and proportion of the elderly population . The 
rate of occurrence of disabilities increases as age increases, which means that as people get older they are less 
active and need more assistance. Canada has the highest rate of institutionalization of elderly citizens in the 
world . Almost 10% of Canadians over the age of 65 are living in long-term care institutions because they can 
no longer safely care for themselves. The increasing number of elderly people in conjunction with the 
increasing frequency of their disabilities will have a big impact on the future of healthcare systems, as it will 
be necessary for them to make adjustments in order to provide adequate services for this population. The next 
section will discuss some aspects that affect the required services of elderly people. 
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The focus of most national aging policies is on dignity, independence, participation, fairness and security , 
since the quality of life of the elderly is very important. Consequently, older adults require a huge share of 
special services and public support. The number of persons requiring formal care (mainly nursing home care) 
and informal care (mainly care at home) will increase sharply even if the proportion of persons at each age 
remains unchanged.  
 
Another issue that will affect providing the necessary services for the elderly is the number of available nurses 
and caregivers. A study about the workforce of aging registered nurses reveals that: a) within 10 years, 40 
percent of working registered nurses (RNs) will be 50 years or older; and b) as those RNs retire, the supply of 
working RNs is projected to be 20 percent below requirements by the year 2020. This shortage of employed 
nurses and caregivers in the coming years will provide significant opportunities for robotics and artificial 
intelligence (AI) researchers to develop assistive technology that can improve the quality of life for the aging 
population.  
 
Self-Feeding Disabilities 

 
In order to assess the demographics that would benefit from assistive devices, specifically for feeding, one 
would typically look to the statistical data available for populations with disabilities in general and the elderly 
specifically. Unfortunately, there is great variation in the incidence of disabilities in the statistics from 
different countries. These differences may be caused by different reporting criteria, degrees of 
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industrialization, rate of accidents, or participation in wars. Statistics for senior populations seem to be more 
telling, as the proportion of seniors in the general population of developed countries is higher than in 
underdeveloped countries. Also, almost 75% of the elderly (aged 65 and over) have at least one chronic illness 
and 50% have at least two chronic illnesses . Chronic conditions can lead to severe and immediate disabilities, 
as well as progressive disabilities that slowly erode the ability of elderly people to care for themselves .  
In general, some of the neuromuscular diseases which cause any disability or dysfunction in the upper-
extremities may hinder the typically easy procedure of eating or make it a very difficult task to accomplish. 
The disabilities that lead to upper-limb disabilities are: Essential Tremor, Parkinson, Dementia/Alzheimer, 
Stroke, Spinal Cord Injury (SCI), Multiple Sclerosis (MS), Cerebral Palsy (CP), Spinal Muscular Atrophy1 
(SMA), Muscular Dystrophy (MD) and Amyotrophic Lateral Sclerosis (ALS). But among these, the first four 
are more common among the elderly. 
Those with essential tremors have difficulty eating normally or holding a cup or glass without spilling it, and 
if the voice or tongue is affected, difficulty in talking may occur. Parkinson , which affects muscle movement 
nerve cells, causes tremors of the fingers and arms, muscle rigidity in the limbs and neck, slowed motion, 
impaired speech, loss of automatic movement, difficulty chewing and swallowing and also problems with 
movement balance and coordination. Dementia and Alzheimer’s disease  can cause a decline in memory, 
comprehension, learning capability, and ability to think, as well as language and judgment. People suffering 
from this kind of disease may see food on their plate, but they cannot logically connect hunger to food to 
feeding. 
 
existing food  Feeding Systems 

 
Food Tray Carry Robot:  
 
People with difficulty in moving their arms can actuate the Food Tray Carry Robot  with very little force 
applied by a finger. The robot arm is a lightweight manipulator, set on the floor beside the patient’s bed. 
Strain gauges installed in a man-machine interface that is attached to the robot’s tip, can detect the force 
applied to the operation plate. The parallel link system in the radial direction has been used to keep the food 
tray even with the ground. Therefore, no actuator or control system is required to maintain the horizontal 
plane of the food tray. The next section lists the prices of some of the previously mentioned feeding devices 
that have made it to the marketplace. Prices are not available for all of the aforementioned devices, largely 
because some have not yet been commercialized and others are still in the research phase of production. 
 
ISAC (Intelligent Soft Arm Control): ISAC , from the Center of Intelligent Systems in Vanderbilt University 
(1991), used a vision system and speech recognition to interact with the elderly through natural commands . 
The system, shown in Figure 2-12, contained a 5-DOF manipulator which was pneumatically controlled by a 
microprocessor-based controller. It benefited from Rubbertuator, which was a pneumatic actuator that 
operated in a manner resembling human muscle. It was light weight, had a high power-to-weight ratio and had 
inherent compliance control characteristics . 
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The system was equipped with three CCD cameras, one located on top of the table for monitoring the food 
and two in front and side of the user to monitor the user’s face. An image processing board could capture 
images from up to four CCD cameras. The control software was distributed among several workstations 
interconnected through an Ethernet LAN. For safety reasons, a collision avoidance subsystem was added to 
the whole system by utilizing real-time face tracking and motion prediction and reactive/predictive motion 
planning. Face tracking planned the approach path to the face and helped in collision prediction/ detection. 
Motion prediction was added to enhance the performance of the face tracking system and also for collision 
avoidance. Considering the fact that this robot arm could feed only one individual person, it was very bulky 
and required considerable space. 
 
Electric Self-Feeder:  
 
The electric self-feeder, made at Sammons Preston Rolyan , is a batterypowered feeder which assists disabled 
people in eating meals at their own speed. A slight head motion on the chin switch activates the motorized 
pusher to fill the spoon and then automatically moves it to the mouth. The rotation of the plate is controlled 
for food selection. A bowl may be substituted for the plate by removing the plate and pusher and adding the 
turntable, shelf, and drip pan. The height can be adjusted. The feeder includes a removable hand or foot 
control for individuals who are unable to operate the chin switch. 
 
Requirements of a self-feeding robot  
 
We surveyed a group of people with disabilities as well as clinical experts to learn about the  
requirements of a feeding robot. The focus group consisted of a person with a spinal cord injury and a person 
with cerebral palsy. The clinical experts included occupational therapists and medical doctors of physical 
medicine and rehabilitation.  
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The major findings of the survey are as follows. f ir s t ly ,  a  us e r  shou ld  b e ab le  to  con tro l the 
feeding interval for the desired food. In the case of caregiving, one of the common problems is the difficulty 
in controlling the feeding interval. People with spinal cord injury are able to talk quickly and can therefore 
manage a short feeding interval. However, people with  
cerebral palsy have difficulty representing their intentions quickly when the feeding interval  
is too short.  
 
Secondly, the specialists and the user candidates believe that the feeding systems are  
designed more for western-style food. Those systems are not suitable for indian food,  
which includes boiled rice, soup, and side dishes. A user eats one of the side dishes and then  
the boiled rice in turn. These steps are performed repetitively during mealtime. In  
comparison with foreign boiled rice, indian boiled rice sticks together very well after  
cooking. One of the problems of self-feeding systems is handling this sticky boiled rice. In  
addition, soup includes meat, noodles, and various vegetables. Therefore, existing  
feeding robots have difficulty handling indian foods 
 
Technically, we considered four types of feeding robots in order to ensure that it can grip  
and release boiled rice effectively, as shown in Fig. 
 
 

 
 
 
In the first concept, a number of bowls are located in front of a user’s mouth, and the food is  
presented by the spoon with a short traveling distance. For example, if there are three bowls,  
one bowl has rice and two bowls have side dishes. However, two side dishes are not enough  
to constitute a satisfying meal. In general, Korean people eat three or four side dishes with  
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boiled rice at a time. Therefore, we need four or five bowls 
 
In the second concept, the bowls are located in the upper front of a user’s mouth, and then the  
food drops from the bottom of a bowl. The food is placed in the spoon by a dropping motion,  
and then the spoon approaches the user’s mouth. This method requires the mechanism of food  
dropping on the spoon. This method could be suitable for a bite-sized rice cake. 
 
In the third concept, the system with a food tray is located on a table. The robotic arm picks  
up food and then moves it to a user’s mouth. These tasks are divided into two steps: one is  
picking up the food and the other is moving the food to the user’s mouth. Two arms can be  
used to perform the above two tasks, respectively. One of the user candidates pointed out  
the easy installation of the feeding robots, especially a dual-arm manipulator. This is  
significant because some caregivers might be elderly people who are not familiar with  
brand-new machines. 
 
 
 
 
PROPOSED SOLUTION 
 
 The designed methodology comprises of a robotic arm and a mechanical setup. The arm is controlled by 
arduino.  Initially height adjustment is done by the power window motor based on switching. If the switch is  
moved ahead means the motor will be rotated in clockwise direction, if the switch is moved towards rear 
position means the motor will be rotated in counter-clockwise direction. Thus through clockwise and counter- 
clockwise action of the motor the desirable height will be obtained. The locomotion of robotic arm is 
accomplished by the servo motors. Based on users need the arduino is programmed and the servo motors are 
rotated on desired angle to feed the food. There will be a switch near to the user‘s feet. If the user need any 
pause or if he feels the food is enough then he can stop the robotic arm moment by pressing the switch. 
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CHAPTER- 

DESIGN CONSIDERATION 

------------------------------------------------------------------------------------  

 

FACTORS DETERMINING THE CHOICE OF MATERIALS 

The various factors which determine the choice of material are discussed  below. 

 

3.1 Properties                                                                         

  The material selected must posses the necessary properties for the proposed 

application.  The various requirements to be satisfied can be weight, surface finish, rigidity, 

ability to withstand environmental attack from chemicals, service life, reliability etc.  The 

following four types of principle properties of materials decisively affect their selection  

 

i. Physical 

ii. Mechanical 

iii. From manufacturing point of view 

iv. Chemical 
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The various physical properties concerned are melting point, Thermal Conductivity, Specific heat, 

coefficient of thermal expansion, specific gravity, electrical Conductivity, Magnetic purposes etc. 

The various Mechanical properties Concerned are strength in tensile, compressive 

shear, bending, torsional and buckling load, fatigue resistance, impact resistance, elastic 

limit, endurance limit, and modulus of elasticity, hardness, wear resistance and sliding 

properties. 

 

The various properties concerned from the manufacturing point of  view are. 

 

 Cast ability 

 weld ability 

 Brazability 

 forge ability 

 merchantability 

 surface properties 

 shrinkage 

 Deep drawing etc. 

 

Manufacturing Case: 

 

Sometimes the demand for lowest possible manufacturing cost or surface qualities 

obtainable by the application of suitable coating substances may demand the use of 

special materials. 

 

Quality Required: 
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This generally affects the manufacturing process and ultimately the material.  For 

example, it would never be desirable to go for casting of a less number of components 

which can be fabricated much more economically by welding or hand forging the steel.  

 

 

 

 

Availability of Material: 

Some materials may be scarce or in short supply.  It then becomes obligatory for the 

designer to use some other material which though may not be a perfect substitute for the 

material designed. 

The delivery of materials and the delivery date of product should also be kept in mind. 

Space Consideration: 

Sometimes high strength materials have to be selected because the forces involved are 

high and the space limitations are there. 

Cost: 

As in any other problem, in selection of material the cost of material plays an important 

part and should not be ignored. 

Some times factors like scrap utilization, appearance, and non-maintenance of the 

designed part are involved in the selection of proper materials. 
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CHAPTER- 

METHODOLOGY 

------------------------------------------------------------------------------------  

 

 
Literature study Make review on other model and focusing on how to make it simple and 

relevance to the project title. 
II. Conceptual design Sketching several type of design based on concept that being choose. 

State the dimension for all part. 
III. Materials Selection Selected the true material based on model design and criteria. Light, 
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easy to joining and easy to manufacture. Assemble all the part to the design.  
IV. Fabrication model refinement. Fabricate according to the main frame and design.  

Refinement at several part of joining and sharp edge. 
V. Performance testing. 
VI. Documentation Preparing a report for the project. 

 

 

 

The proper selection of material for the different part of a machine is the main objective in the 

fabrication of machine. For a design engineer it is must that he be familiar with the effect, 

which the manufacturing process and heat treatment have on the properties of materials. The 

Choice of material for engineering purposes depends upon the following factors:  

 

 Availability of the materials. 

 Suitability of materials for the working condition in service. 

 The cost of materials. 

 Physical and chemical properties of material. 

Mechanical properties of material.The mechanical properties of the metals are those, which 

are associated with the ability of the material to resist mechanical forces and load. We shall 

now discuss these properties as follows: 

 Strength : It is the ability of a material to resist the externally applied forces 

 Stress: Without breaking or yielding. The internal resistance offered by a part to an 

externally applied force is called stress. 

 Stiffness: It is the ability of material to resist deformation under stresses. The modules 

of elasticity of the measure of stiffness. 
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CHAPTER- 
BLOCK DIAGRAM 

------------------------------------------------------------------------------------  

 

BLOCK DIAGRAM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SWITCH 

POWER 
SUPPLY 

CONTROLLER 
UNIT 

CONVERTER 

MOTOR 1 

MOTOR 2 

MOTOR 3 

MOTOR 4 
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The various components present in the assistive feeding device are shown in the figure 1. It 
incorporates a battery which acts as an energy source for providing electricity to the device. Arduino 
controller is used to controlling the rotation of the servo motors by sending the PWM (Pulse Width 
Modulation). The robotic arm is rotated based upon the revolution of servomotors. The converter used here is 
buck converter which regulates the voltage to 5V. After regulating the voltage to 5V the power will be fed to 
the controller and the switch. 

 
 
 
 
 
 
 

 

CHAPTER- 
WORKING PRINCIPLE 

------------------------------------------------------------------------------------  
 
 
 
 
WORKING PRINCIPLE 
 
The components here used are arduino uno board, capacitors, servo SG90,10k pot variable resistor. 

Now talking about servo motors they are excessively used when there is a need for a accurate shaft movement 
or position. These are not proposed for a high sped applications. Servo motors are proposed for low speed, 
medium torque and accurate position application. So they are best for designing robotic arm. Servo motor are 
available at different shapes and sizes. We are going to use small servo motors (four) a servo motor will have 
mainly three wires positive voltage another is for ground and the last one is for position setting.  

 
1. The arm has been built with ply wood and the individual parts have been locked to servo motors. 

Arduino Uno is programmed to control servo motors. Servos motors are acting as joints of Robotic 
arm here. This setup looks a like degrees, these are excessively used when there is a need for accurate 
shaft movement or position. These are not proposed for high speed applications. They are proposed 
for low speed, medium torque and accurate position application. 

2.  This Robotic Arm is controlled by four Potentiometer with which we attach each with potentiometer 
that is used to control each servo. We can move these servos by rotating the potentiometer to pick 
some object, with some practice we can easily pick and move the object from one place to another. 
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Here we use low torque servos here but we can use more powerful servos 
3. Program done using Arduino 1.6.10.  
4.  We connect the circuit according to circuit diagram.  
5. Now the voltage provided by these variable resistor voltage which represents position control into 

ADC channels of Arduino.  
6. We are going to use four ADC channels of UNO from A0 to A3. After the ADC initialization, we 

will have digital value of pots representing the position needed by user.  
7. We will take this value and match it with servo position.  
8. The robotic arms takes a perfect scaling that is cardboard, foam board is cut using measuring a servo 

are fitted according so that position of one servo motor does not affect the position of other servo 
motor. 

9.  As we rotate the 10K pot the value changes accordingly and we get rotation in the output of servo 
motor. 

10.  The voltage across variable resistors is not completely linear; it will be a noisy one. So to filter out 
this noise, capacitors are placed across each resistor. 

 
 

 

CHAPTER- 
COMPONENTS AND DESCRUPTION 

------------------------------------------------------------------------------------  

 

 
 

 

COMPONENTS AND DESCRIPTION  
 
 

Arduino Uno  

Arduino Uno is a microcontroller board based on 8-bit ATmega328P microcontroller. Along with 

ATmega328P, it consists other components such as crystal oscillator, serial communication, voltage regulator, 

etc. to support the microcontroller. Arduino Uno has 14 digital input/output pins (out of which 6 can be used 

as PWM outputs), 6 analog input pins, a USB connection, A Power barrel jack, an ICSP header and a reset 

button. 

 

http://www.ijsrem.com/


          International Journal of Scientific Research in Engineering and Management (IJSREM)  

           Volume: 05 Issue: 07 | July - 2021                                                                                                    ISSN: 2582-3930                                  

 

© 2021, IJSREM      | www.ijsrem.com                                                                                                 |        Page 18 

 
 

 

 

How to use Arduino Board 

The 14 digital input/output pins can be used as input or output pins by using pinMode(), digitalRead() and 

digitalWrite() functions in arduino programming. Each pin operate at 5V and can provide or receive a 

maximum of 40mA current, and has an internal pull-up resistor of 20-50 KOhms which are disconnected by 

default.  Out of these 14 pins, some pins have specific functions as listed below: 

 Serial Pins 0 (Rx) and 1 (Tx): Rx and Tx pins are used to receive and transmit TTL serial data. They are 

connected with the corresponding ATmega328P USB to TTL serial chip. 

 External Interrupt Pins 2 and 3: These pins can be configured to trigger an interrupt on a low value, a rising 

or falling edge, or a change in value. 

 PWM Pins 3, 5, 6, 9 and 11: These pins provide an 8-bit PWM output by using analogWrite() function. 

 SPI Pins 10 (SS), 11 (MOSI), 12 (MISO) and 13 (SCK): These pins are used for SPI communication. 

 In-built LED Pin 13: This pin is connected with an built-in LED, when pin 13 is HIGH – LED is on and 

when pin 13 is LOW, its off. 

Along with 14 Digital pins, there are 6 analog input pins, each of which provide 10 bits of resolution, i.e. 1024 

different values. They measure from 0 to 5 volts but this limit can be increased by using AREF pin with 

analog Reference() function.   
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 Analog pin 4 (SDA) and pin 5 (SCA) also used for TWI communication using Wire library. 

Arduino Uno has a couple of other pins as explained below: 

 AREF: Used to provide reference voltage for analog inputs with analogReference() function. 

 Reset Pin: Making this pin LOW, resets the microcontroller. 

  

Communication 

Arduino can be used to communicate with a computer, another Arduino board or other microcontrollers. The 

ATmega328P microcontroller provides UART TTL (5V) serial communication which can be done using 

digital pin 0 (Rx) and digital pin 1 (Tx). An ATmega16U2 on the board channels this serial communication 

over USB and appears as a virtual com port to software on the computer. The ATmega16U2 firmware uses the 

standard USB COM drivers, and no external driver is needed. However, on Windows, a .inf file is required. 

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the 

Arduino board. There are two RX and TX LEDs on the arduino board which will flash when data is being 

transmitted via the USB-to-serial chip and USB connection to the computer (not for serial communication on 

pins 0 and 1). A SoftwareSerial library allows for serial communication on any of the Uno's digital pins. The 

ATmega328P also supports I2C (TWI) and SPI communication. The Arduino software includes a Wire library 

to simplify use of the I2C bus. 

  

Arduino Uno to ATmega328 Pin Mapping 

When ATmega328 chip is used in place of Arduino Uno, or vice versa, the image below shows the pin 

mapping between the two. 
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Software 

Arduino IDE (Integrated Development Environment) is required to program the Arduino Uno board.  

  

Programming Arduino 

Once arduino IDE is installed on the computer, connect the board with computer using USB cable. Now open 

the arduino IDE and choose the correct board by selecting Tools>Boards>Arduino/Genuino Uno, and choose 

the correct Port by selecting Tools>Port. Arduino Uno is programmed using Arduino programming language 

based on Wiring. To get it started with Arduino Uno board and blink the built-in LED, load the example code 

by selecting Files>Examples>Basics>Blink. Once the example code (also shown below) is loaded into your 

IDE, click on the ‘upload’ button given on the top bar. Once the upload is finished, you should see the 

Arduino’s built-in LED blinking.  Below is the example code for blinking: 

 

 

example 

 

// the setup function runs once when you press reset or power the board 

void setup() { 

http://www.ijsrem.com/
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  // initialize digital pin LED_BUILTIN as an output. 

  pinMode(LED_BUILTIN, OUTPUT); 

} 

 

// the loop function runs over and over again forever 

void loop() { 

  digitalWrite(LED_BUILTIN, HIGH);   // turn the LED on (HIGH is the voltage level) 

  delay(1000);                       // wait for a second 

  digitalWrite(LED_BUILTIN, LOW);    // turn the LED off by making the voltage LOW 

  delay(1000);                       // wait for a second 

} 

  

Applications 

 Prototyping of Electronics Products and Systems 

 Multiple DIY Projects. 

 Easy to use for beginner level DIYers and makers. 

 Projects requiring Multiple I/O interfaces and communications 

 

L298N 
This allows you to control the speed and direction of two DC motors, or control one bipolar stepper motor 
with ease. The L298N H-bridge module can be used with motors that have a voltage of between 5 and 35V 
DC. There is also an onboard 5V regulator, so if your supply voltage is up to 12V you can also source 5V 
from the board. 
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1. DC motor 1 "+" or stepper motor A+  
2. DC motor 1 "-" or stepper motor A 
3. 12V jumper - remove this if using a supply voltage greater than 12V DC. This enables power to the 
onboard 5V regulator  
4. Connect your motor supply voltage here, maximum of 35V DC. Remove 12V jumper if >12V DC  
5. GND 
6. 5V output if 12V jumper in place, ideal for powering your Arduino (etc)  
7. DC motor 1 enable jumper. Leave this in place when using a stepper motor. Connect to PWM output for 
DC motor speed control.  
8. IN1-Input 
 9. IN2-Input  
10. IN3-Input  
11. IN4-Input 
 12. DC motor 2 enable jumper. Leave this in place when using a stepper motor. Connect to PWM output for 
DC motor speed control.  
13. DC motor 2 "+" or stepper motor B+ 
 14. DC motor 2 "-" or stepper motor B 
 
 
Controlling DC Motors 
To control one or two DC motors is quite easy. First connect each motor to the A and B connections on the 
L298N module. If you're using two motors for a robot ensure that the polarity of the motors is the same on 
both inputs. Otherwise you may need to swap them over when you set both motors to forward and one goes 
backwards! Next, connect your power supply - the positive to pin 4 on the module and negative/GND to pin 5. 
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If you supply is up to 12V you can leave in the 12V jumper (point 3 in the image above) and 5V will be 
available from pin 6 on the module. This can be fed to your Arduino's 5V pin to power it from the motors' 
power supply. Don't forget to connect Arduino GND to pin 5 on the module as well to complete the circuit. 
Now you will need six digital output pins on your Arduino, two of which need to be PWM (pulse-width 
modulation) pins. PWM pins are denoted by the tilde ("~") next to the pin number, for example: 

 
Finally, connect the Arduino digital output pins to the driver module. In our example we have two DC motors, 
so digital pins D9, D8, D7 and D6 will be connected to pins IN1, IN2, IN3 and IN4 respectively. Then 
connect D10 to module pin 7 (remove the jumper first) and D5 to module pin 12 (again, remove the jumper). 
The motor direction is controlled by sending a HIGH or LOW signal to the drive for each motor (or channel). 
For example for motor one, a HIGH to IN1 and a LOW to IN2 will cause it to turn in one direction, and a 
LOW and HIGH will cause it to turn in the other direction. However the motors will not turn until a HIGH is 
set to the enable pin (7 for motor one, 12 for motor two). And they can be turned off with a LOW to the same 
pin(s). However if you need to control the speed of the motors, the PWM signal from the digital pin connected 
to the enable pin can take care of it. 
 
TECHNICAL SPECIFICATIONS 
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Relay  
In shows are a relay is an electrically operated switch. Several relays use a magnet to automatically operate a 
switch, however alternative in operation principles are used, like solid state relays. Relays are used wherever 
it's necessary to regulate a circuit by a separate low-power signal, or wherever many circuits should be 
controlled by one signal. The essential relays were handling in long distance communicate circuits as 
amplifiers, they unbroken the signal coming back in from one circuit and re-transmitted it on another circuit. 
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History of AVR AVR was developed in the year 1996 by Atmel Corporation. The architecture of AVR was 
developed by Alf-Egil Bogen and Vegard Wollan. AVR derives its name from its developers and stands for 
Alf-Egil Bogen Vegard Wollan RISC microcontroller, also known as Advanced Virtual RISC. The 
AT90S8515 was the first microcontroller which was based on AVR architecture however the first 
microcontroller to hit the commercial market was AT90S1200 in the year 1997. 

 
AVR microcontrollers are available in three categories: 
 1. Tiny AVR – Less memory, small size, suitable only for simpler applications  
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2. Mega AVR – These are the most popular ones having good amount of memory (up to 256 KB), higher 
number of inbuilt peripherals and suitable for moderate to complex applications.  
3. mega AVR – Used commercially for complex applications, which require large program memory and high 
speed. 
 
Soldering  
The next process after the component mounting is soldering; solder pint is achieved by heating the solder and 
base metal about the melting point of the solders used. The necessary heat depends upon  
1) The nature and type of joints  
2) Melting temperature of solder  
3) Flux Soldering techniques are of so many types but we are using iron soldering. 
Procedure of Soldering The points to be joined must be cleaned first and fluxed. The hard solder iron and 
solder wire is applied to the work. The melted solder becomes bright and fluid. The iron must be removed 
after sufficient time and joint is allowed to coal. At the end, finishing is done. 
 
 
MAJOR SOFTWARE REQUIRED 
Arduino Software (IDE) : The open-source Arduino Software (IDE) makes it easy to write code and upload it 
to the board. It runs on Windows, Mac OS X, and Linux. The environment is written in Java and based on 
Processing and other open-source software. This software can be used with any Arduino board. For latest 
software refer to link. https://www.arduino.cc/en/Main/Software  
 Arduino was born at the Ivrea Interaction Design Institute as an easy tool for fast prototyping, aimed at 
students with or without a background in electronics and programming.  
 Arduino is an open-source prototyping platform based on easy-to-use hardware and software.  
 Arduino boards are able to read inputs - light on a sensor, a finger on a button, or a message - and turn it into 
an output - activating a motor, turning on an LED, publishing  
You can tell your board what to do by sending a set of instructions to the microcontroller on the board.  
 To do so you use the Arduino programming language (based on Wiring), and the Arduino Software (IDE), 
based on Processing. 
Inexpensive - Arduino boards are relatively inexpensive compared to other microcontroller platforms. Cross-
platform 
 - The Arduino Software (IDE) runs on Windows, Macintosh OSX, and Linux operating systems. Most 
microcontroller systems are limited to Windows. Simple, clear programming environment 
 - The Arduino Software (IDE) is easy-to-use for beginners, yet flexible enough for advanced users to take 
advantage of as well. 
Open source and extensible hardware - The plans of the Arduino boards are published under a Creative 
Commons license, so experienced circuit designers can make their own version of the module, extending it 
and improving it. 
Open source and extensible software - The Arduino software is published as open source tool and the 
language can be expanded through C++ libraries. 
 
How to use Arduino IDE Tool Steps for using Arduino IDE: Step  
1: Get an Arduino board and USB cable: In this tutorial, we assume you're using an Arduino Uno You also 
need a standard USB cable (A plug to B plug): the kind you would connect to a USB printer, for example. 

http://www.ijsrem.com/
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Step 2 : Download the Arduino environment:  
(https://www.arduino.cc/en/Main/Software) Get the latest version from the download page. When the 
download finishes, unzip the downloaded file. Make sure to preserve the folder structure. Double-click the 
folder to open it. There should be a few files and sub-folders inside. 
Step 3 : Connect the board: The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw 
power from either the USB connection to the computer or an external power supply. If you're using an 
Arduino Diecimila, you'll need to make sure that the board is configured to draw power from the USB 
connection. The power source is selected with a jumper, a small piece of plastic that fits onto two of the three 
pins between the USB and power jacks. Check that it's on the two pins closest to the USB port. Connect the 
Arduino board to your computer using the USB cable. The green power LED (labelled PWR) should go on. 
Step 4 : Install the drivers: Installing drivers for the Arduino Uno or Arduino Mega 2560 with Windows7, 
Vista, or XP 
Step 5: Launch the Arduino application: Double-click the Arduino application. (Note: if the Arduino software 
loads in the wrong language, you can change it in the preferences dialog. See the environment page for details.  

 
 
 
 
Step 6: Open the blink example Open the LED blink example sketch: File > Open > Temp_and_humid.ino 

http://www.ijsrem.com/
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Step 7: Select your board: You'll need to select the entry in the Tools > Board menu that corresponds to your 
Arduino.  
Step 8: Select your serial port : Select the serial device of the Arduino board from the Tools | Serial Port 
menu. This is likely to be COM3 or higher (COM1and COM2 are usually reserved for hardware serial ports). 
To find out, you can disconnect your Arduino board and re-open the menu; the entry that disappears should be 
the Arduino board. Reconnect the board and select that serial port. 
Step 9 : Upload the program: Now, simply click the "Upload" button in the environment. Wait a few seconds - 
you should see the RX and TX leds on the board flashing. If the upload is successful, the message "Done 
uploading." will appear in the status bar. 
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Embedded C Embedded C is a set of language extensions for the C Programming language. C is often used 
for system programming, including implementing applications. Embedded C uses most of the syntax of 
standard C, e.g., main() function, variable definition, data type declaration, conditional statements (if, switch, 
case), loops (while, for), functions, arrays and strings, structures etc. It is small and simpler to learn, 
understand, program and debug. It is efficient & supports access to I/O and provides ease of management of 
large embedded projects. The compiler derives its name from the way it works, looking at the entire piece of 
source code and collecting and reorganizing the instruction. See there is a bit little difference between 
compiler and an interpreter. Interpreter just interprets whole program at a time while compiler analyzes and 
execute each line of source code in succession, without looking at the entire program 
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advantages  
1) Conduct experiments of any complexity without human error  
2) Quickly and accurately repeat experiments  
3) Run tests 24/7 and monitor the system remotely  
4) Tedious experiments require no additional labor cost  
5) Scale to as many plants as needed  
6) Use the sequence builder instead of checklists  
7) Run more tests with fewer scientists  
8) Test unlimited groups simultaneously (not just A and B)  
9) Systematically collect data at a high frequency  
10) Run experiments that are traditionally too labor intensive 
 
 

SERVO MOTORS 

 

 

 

DC Servo Motor 
 

DC Servos are used for providing fast torque response and are also known as a permanent magnet DC motor 

or separately excited DC motor. The reason behind providing fast torque response is because of the torque and 

flus are decoupled. Thus, a small variation in the armature voltage or current can produce a notable shift in the 

position or speed of the shaft. DC servos are most used servo motors among all the types. 
Servo motors have many reasons for being used in a robotic arm, with the main reason being that the 
servo motor’s position, velocity and torque can be controlled as required which is necessary when 
building a robotic arm. 

Below are other reasons servo motors are used in a robotic arm: 
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 Different sizes available 
 Inexpensive 
 Easy to use 
 Readily Available 
 Weight (much lighter) 

 

Construction of Servo Motor 

The Servo motor is DC motor which has 5 following parts:- 

 

1. Stator Winding: This type of winding wound on the stationary part of the motor. It is also known as field 
winding of the motor. 

2. Rotor Winding: This type of winding wound on the rotating part of the motor. It is also known as an 
armature winding of the motor. 

3. Bearing: These are of two types,i.e, font bearing and back bearing which are used for the movement of the 

shaft. 
4. Shaft: The armature winding is coupled on the iron rod is known as the shaft of the motor. 

5. Encoder: It has the approximate sensor which determines the rotational speed of motor and revolution per 
minute of the motor. 

 

 

 

 

 

 

Microcontroller interface with servo motor: 
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In this research work, the hardware system uses two phase AC servo motor for precise position control and the 

single phase AC supply is given to the main winding. Based on the user instruction given to the input port, 

control voltage is produced at the output port and which is finally given to the servomotor as shown in fig: 

3.The rotation of the motor is controlled by the phase difference between the main winding and the control 

winding 

 

Spoon 

 

 Here the normal spoon is designed to use for this system. In this,the studs of the two spoons are attached at 

one end of the spoon as shown in fig:6 , with the help of that stud the spoon can be fixed into the holder. 

Mouth of the spoon can be changed to make the system suitable foreating from small size to large pieces of 

food. 

Eating Bowl 

 

This eating bowl design is very important in this system . We cannot employ a round bowl or any other 

design. It should be designed in parabolic shape (i.e. like fish ing boat). Its inner surface should be curved 
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because in each rotation food will get settled at the center of the bowl by parabolic design the food will focus 

at center place of the bowl. So the spoon can easily collect the food from bowl 

 

 

CHAPTER- 
DESIGM MODELING AND DIMENSIONING 

------------------------------------------------------------------------------------  
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CHAPTER- 
COST ESTIMATION  

------------------------------------------------------------------------------------  

 

1.MATERIAL COST: 

Components Material Amount (Rs) 

frame Mild steel C 40 2000/- 

Servo motor ece 2600/- 

converter …… 180/- 

Arduino controller ……. 650/- 

Jumper pins …… 240 

Adaptor ac ….. 280/- 

Bowl,spoon,nut,bolts,connecting 

wire etc., 

….. 500/- 

 Total  6450/- 

                                                                                                                     

 

 

 OVERHEAD CHARGES 
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The overhead charges are arrived by “Manufacturing cost” 

 

 Manufacturing Cost = Material Cost   

    = 6450/-   

 Overhead Charges = 20% of the manufacturing cost  

    = 1290/- 

 

TOTAL COST 

 

Total cost = Material Cost + Labour cost + Overhead Charges 

  = 14430/-  +  1290/- 

  = 7740/- 

 

Total cost for this project = 7740/- 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ijsrem.com/


          International Journal of Scientific Research in Engineering and Management (IJSREM)  

           Volume: 05 Issue: 07 | July - 2021                                                                                                    ISSN: 2582-3930                                  

 

© 2021, IJSREM      | www.ijsrem.com                                                                                                 |        Page 40 

 
 

CHAPTER- 
ADVANTAGE AND DISADVANTAGE 

 

ADVANTAGE 

 Its  cost  affordable robot 

 Design and handling is kept simple and effective 

 Start and stop can be done in single switch 

 Timing can be adjusted according to the comfort 

 This system is safe and not  hurtable 

 Reduction in fatigue for the guardian 

 Increase in personnel comfort for the disables 

 
 
 
 
DISADVANTAGE 
 
 

 Its works on fixed position,person needs to suit accordingly  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ijsrem.com/


          International Journal of Scientific Research in Engineering and Management (IJSREM)  

           Volume: 05 Issue: 07 | July - 2021                                                                                                    ISSN: 2582-3930                                  

 

© 2021, IJSREM      | www.ijsrem.com                                                                                                 |        Page 41 

 
 

 
 
 
 

 

CHAPTER- 
RESULTS AND CONCLUSION 

------------------------------------------------------------------------------------  

 
RESULTS AND CONCLUSION 
 
The assistive feeding device takes around 22seconds to complete one rotation (from taking food to 

feeding the disabled). Its further movement depends upon the input using the push button (manual input).It 
feeds 200 grams of food in 20 minutes.  
This project report has investigated the design of a assistive feeding device for the developing world and 
presented a novel solution to the problem. The design incorporates the following features,  
 Helps the persons with disabled upper limbs to take meals by themselves.  
 It allows the user to adjust the height at the required level. 
  This assistive feeding device has a switch near to the user‘s feet to pause the movement of the arm at any 
condition. 
  It helps the user (differently able) to have their food comfortably. The self-feeding device feeds the food 
properly with enough time. It assists physically challenged peoples to have their food on their own. This 
device enabled the design of a efficient, affordable robotic arm for feeding the food. 
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